PURCHASE AGREEMENT

THIS AGREEMENT is made and entered into this _~ day of ,2019, by
and between the CITY OF BILLINGS, MONTANA, a municipal corporation organized and
existing under the laws of the State of Montana, P.O. Box 1178, Billings, Montana 59103,
hereinafter referred to as “City,” and, Ovivo USA, LLC, hereinafter referred to as “Seller.”

In consideration of the mutual covenants and agreements herein contained, the receipt and
sufficiency whereof being hereby acknowledged, the parties hereto agree as follows:

1. PRODUCT PURCHASED: Seller agrees to sell and City agrees to purchase the
goods (“Product”) as described below and per written City’s specifications and Seller’s proposal
attached hereto as Exhibit “A,” which are incorporated into this agreement and includes Seller’s
attached amendment by this reference. The Product being purchased consists of:

Item Price
One Model 900 Jones + Attwood 270 design JETA Grit Trap $82,800.00
and One Gorman-Rupp T4A71S-B Self-Priming Grit Pump

24 Price: The City agrees to pay Eighty Two Thousand Eight Hundred Dollars and
No/100 ($82,800.00) as the purchase price. All prices are inclusive of any applicable local, state or
federal taxes that may be applied to the product to be purchased. The purchase price is free on board
at the place of delivery and Seller may not impose any additional, shipping, delivery or storage
charges.

3. Delivery and Payment: Seller agrees to deliver the above-described goods or
product to City by December 31.2019 unless otherwise provided in this Agreement. Delivery will
occur at City of Billings, MT Water Reclamation Facility or at a place otherwise selected by City.

Upon delivery, City may inspect the goods or product to ensure that it meets City specifications, and
Seller may obtain specifications from City upon request. If the Product meets City specifications,
City shall tender the purchase price stated above to Seller through the City’s normal claim process.

4. Specifications: Seller agrees that this Product complies with the City’s specifications
provided to Seller and with the Seller’s proposal thereto as accepted by the City. Unless otherwise
agreed to by the City, the City’s specifications govern and control in the event of inconsistencies
with the Seller’s response to the same.
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s. Indemnity, Insurance and Bonds: Seller agrees to indemnify, defend and save City,
its officers, agents and employees harmless from any and all losses, damage and liability occasioned
by, growing out of, or in any way arising or resulting from any intentional or negligent act on the part
of Seller or its agents or employees. For this purpose, Contractor shall provide City with proof
of both Commercial General liability and automobile insurance each issued by a reliable
company or companies for personal injury and property damage, in an amount not less than
$1.5 million per occurrence. The City shall be named as an additional insured on all policies
other than professional liability and worker’s comp. The insurance must be in a form suitable
to City.

Seller shall furnish an approved Performance Bond and a Labor and Materials Payment
Bond, each in the amount of one hundred percent (100%) of the contract amount.

6. Nondiscrimination: Seller agrees that all hiring by Seller of persons performing this
Agreement will be on the basis of merit and qualification and will not discriminate on the basis of
race, color, religion, creed, political ideas, sex, age, marital status, physical or mental disability, or
national origin.

The Contractor and subcontractor shall abide by the requirements of 41 CFR 60-3 00.5(a) and
41 CFR 60-741.5(a), which prohibit discrimination against qualified protected veterans and/or
qualified individuals on the basis of disability, and requires affirmative action by covered prime
contractors and subcontractors to employ and advance in employment qualified protected veterans
and individuals with disabilities.

7. Default and Termination: If Seller fails to deliver the goods or product as set forth
in Paragraphs 2 and 3 above, or violates any provision of this Agreement, or if the goods or product
fails to meet City’s specifications, City may, at its option, declare the Seller in default and
immediately cancel and rescind this Agreement. Thereafter, City may procure substitute goods or
product to replace the goods or product described herein. In such event, Seller is liable to City for
the difference between the price set forth herein and the price paid by City for replacement goods or
product. Additionally, the City may pursue any other remedy it has at law or in equity.

8. Warranty: Unless superseded or supplemented by an express warranty, Seller
represents and warrants that the Product are covered by implied warranties for merchantability and
fitness for the particular purpose for which they have been purchased.

9. Assignment: Seller may not assign this Agreement or any of its rights hereunder
without the express written consent of City.
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10. Entire Agreement: This Agreement, including its appendices, if any, is the entire
understanding between the parties relating to the subject matter contained herein. No agent or
representative of either party has authority to make any representations, statements, warranties or
agreements not herein expressed and all modifications or amendments of this agreement, including
the appendices, must be in writing and signed by an authorized representative of each of the parties
hereto.

11. Governing Law and Venue: This Agreement shall be construed and enforced in
accordance with the laws of the State of Montana. Venue for any suit between the parties arising out
of this Agreement shall be the State of Montana Thirteenth Judicial District Court, Yellowstone
County.

IN WITNESS WHEREOF, the parties hereto have executed this instrument the day and
year first above written.

CITY OF BILLINGS, MONTANA

SELLER (Print Business Name Above)

By By
WILLIAM A. COLE
MAYOR Print Name
Print Title
APPROVED AS TO FORM
By

BRENT BROOKS, City Attorney
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Amendment to Purchase Agreement
One Model 900 Jones + Atwood 270 Design JETA Grit Trap

The following Amendment terms and conditions are hereby incorporated into the Purchase Agreement
("Contract"). In the event of conflict between the Contract documents and the Amendment herein, the terms
and conditions of the Amendment shall control. The parties are City of Billings, Montana ("the City") and Ovivo
USA, LLC ("Seller").

Limitation of Liability and Consequential Damage Disclaimer

To the extent permissible by applicable law, Seller shall have no further liability in connection with this Contract
in excess of the cost of correcting any defects, or in the absence of any defect, in excess of the value of the
equipment supplied hereunder. However, notwithstanding any other provision of the Contract to the contrary,
in no event shall Seller be liable for any punitive, exemplary, special, incidental, or consequential loss or damage
suffered by the City, or any other party, in connection with this Contract.

These limits shall not apply to third party claims based on injury, death, or property damage. For the purpose of
this term, the equipment provided in accordance with the requirements of this project shall not be considered
property and shall instead be covered under the terms of the warranty herein. These limits shall not apply to
claims which are based on the willful misconduct, gross negligence, or fraud of the Seller.

Indemnity
Any and all indemnity obligations of Seller in connection with this Contract shall be limited to the extent of to its
negligence or willful misconduct.

Insurance
All insurance coverage requirements may be fulfilled through any combination of primary and excess insurance.

Bonds
In no event shall Seller be required to provide Bonds for a duration which exceeds the first twenty four (24)
months of the warranty period.

City of Billings, Montana Ovivo USA, LLC
(“the City”) (“Seller”)

By: By:

Name: Name:

Title: Title:

Date: Date:




Worldwide Experts CONFIDENTIAL PROPOSAL
in Water Treatment

1-54-0052 REV 2.1

Friday, June 07, 2019

CITY OF BILLINGS, MT
WASTEWATER TREATMENT PLANT

PREPARED FOR

HDR CONSULTING
Attn: Francis Rodriguez

AREA REPRESENTATIVE

Ambiente H20 Inc.
Ben Lewis
blewis@ambienteh2c.com

PREPARED BY

Randy Robison Ovivo USA, LLC
Product Manager, Ovivo USA, LLC. 4246 Riverboat Road - Suite 300
P: 801-931-3317 Salt Lake City, Utah 84123-2583

C: 385-707-3508
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Date: June 7, 2019
Revision: 2.1
Project:  City of Billings, MT WWTP

Ovivo USA, LLC greatly values this opportunity to present our finalized proposal for the
equipment / services as defined herein for the City of Billings, Montana Waste Water Treatment
Facility.

This proposal as well as the attached amendment, either in its original form or in its “as sold”
format, constitutes Ovivo’s contractual offer of goods and services in connection with the Project.

Ben Lewis with Ambiente H:0, is Ovivo’s local sales representative in your area and is available
to address any questions or comments you may have in connection with this proposal.

Please note the following contact info for Ben (Ambiente H,0):

A
TE Wastewater &
AMB'ENTE W:;:\;ranainwm

@IN(. Specislists

525 St. Johns Ave. Suite D
Billings, MT 59102

Telephone: 406-850-0030
Facsimile:  303-380-0664
Email: blewis@ambienteh2o.com

Revision 2.1 Final Selling Price

Item Specification Equipment Freight

I 4623 23 Forced Vortex Type Grit Removal Equipment | FCA to site $82,800.%°

Ovivo USA, LLC | 4246 Riverboat Road, Suite 300, Salt Lake City, Utah 84123 USA | Tel: (801) 931-3000 | Fax: (801) 931-3080
ovivowater.com
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ITEM | - VORTEX GRIT REMOVAL SYSTEM - SPECIFICATION SECTION 46 23 23

OVIVO shall furnish equipment for one (1) mechanically-induced vortex type grit chamber for installation
by others. The scope of supply shall include one (1) Model 900 Jones + Attwood 270 design JETA® Grit
Trap and one (1) Gorman-Rupp grit pump. The system shall be designed in accordance to OVIVO's
standard engineering practices and will include the following items:

ITEMS INCLUDED:

One (1) Jeta® Grit Trap, Model 900, 270 design, to include:
e 1.0 HP, TEFC helical gear motor suitable for 460/3/60 supply for Class |, Division 1.

e 10.75 inch O.D. drive tube — 3/8 inch thick, 304 Stainless Steel.

e 1/8inch 304 stainless steel air bell protects the gearbox from flood water.
e Flat disk impeller with adjustable blades — % inch thick, 304 Stainless Steel.
e 4.0 inch diameter suction tube - 304 Stainless Steel.

e 1.5 inch diameter fluidization line — 304 stainless steel.

e 1.5 inch solenoid for fluidizing line, Class 1, Division 1.

e Two (2) manual isolation valves.

One (1) Gorman-Rupp T4A71S-B self-priming grit pump, to include:
e 10 HP motor, 1760 RPM, 460/3/60 supply for Class I, Division 1.

e Capacity of 200 GPM at 43 feet of head.

e 4.0inch inlet/4.0 inch outlet.

e Casing — Grey Cast Iron No.30.

e Suction and discharge flanges — Grey cast iron No. 30.
e Suction flap valve — molded neoprene.

e Stainless steel shaft.

e Seal plate - Ductile iron hardened to 400 Brinell.
e Gaskets — Compressed synthetic fiber and Teflon.
e Frame — Carbon steel.

e O-Rings —Buna-N & Viton.

e Pressure release valve — Bronze.

e Factory re-prime test.

e Anchor bolts — 316 stainless steel.

e Fasteners — 316 stainless steel.

Freight:
e FCA jobsite.

Grit System O&M Manuals / Drawings:
e Five (5) Printed copies

e One (1) Digital copy

Ovivo USA, LLC | 4246 Riverboat Road, Suite 300, Salt Lake City, Utah 84123 USA | Tel: (801) 931-3000 | Fax: (801) 931-3080
ovivowater.com



PROPOSAL | 1-54-0052 REV 2 | 7 June 19 | Page 4

Field Service:
e One (1) Round trip to site.

e One (1) OVIVO service technician

e Two (2) Days on site

The service technician shall be on site for commissioning, equipment start-up and operator training.

The Contractor will be responsible for the crane, labor and supervision required to install the new OVIVO
equipment.

A sloped floor is required to be grouted in on top of the upper chamber of the grit trap if not previously
installed by the contractor.

SPARE PARTS:

Two (2) Gear drive lubricant replacement fill
One (1) Spare gear motor
One (1) Spare pump motor

One (1) Spare mechanical drive

ITEMS NOT INCLUDED (But not limited to the following):

Any items not specifically included above, such as:
Taxes.

Grit dewatering screws.
Electrical controls including control panels and local stations.

All piping and valves on the discharge side of the grit pump between the pumps and the grit
dewatering screw.

Offloading at job site.

Insulation or heat tracing of any components.
Heat tracing tape for small diameter pipe.
Installation.

Access ladder or stairs.

JETA® drive and bridge for JETA® drive.
Spare belts.

Drive access platform.

Disconnect switches.

Concrete work.

Civil design.

Electrical connections.

Electrical wiring and installation.

Finish painting.

Ovivo USA, LLC | 4246 Riverboat Road, Suite 300, Salt Lake City, Utah 84123 USA | Tel: (801) 931-3000 | Fax: (801) 931-3080
ovivowater.com
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CLARIFICATIONS — EXCEPTIONS:

Ovivo USA, LLC makes the following clarifications and exceptions to the proposal.

SECTION or DRAWING COMMENT

2.2 Materials: The Gorman-Rupp self-priming grit pump is being supplied
which does not meet all the specifications in this section;
however, this pump was originally supplied for the project and
is what is drawn in the contract drawings.

2.3 Equipment: As noted above, the Gorman-Rupp pump may not meet all the
requirements of this section. It will meet the required flow and
head specified.

DELIVERY

Ovivo will submit drawings for approval within six (6) weeks after Purchaser’s receipt of Ovivo’s
written acknowledgement of an approved purchase order. Ovivo intends to ship all Products
eighteen (18) weeks after receipt of approved drawings from Purchaser. However, the dates of
drawing submission and shipment of the Products represents Ovivo's best estimate, but is not
guaranteed, and Ovivo shall not be liable for any damages due to late delivery. The Products shall
be delivered to the delivery point or points in accordance with the delivery terms stated in this
proposal. If such delivery is prevented or postponed by reason of Force Majeure, as defined in
Ovivo’s standard terms and conditions of sale, Ovivo shall be entitled at its option to tender
delivery to Purchaser at the point or points of manufacture, and in default of Purchaser’s
acceptance of delivery, to cause the Products to be stored at such a point or points of manufacture
at Purchaser's expense. Such tender, if accepted, or such storage, shall constitute delivery for all
purposes of this proposal. If shipment is postponed at request of Purchaser, or due to delay in
receipt of shipping instructions, payment of the purchase price shall be due on notice from Ovivo
that the Products are ready for shipment. Handling, moving, storage, insurance and other charges
thereafter incurred by Ovivo with respect to the Products shall be for the account of Purchaser
and shall be paid by Purchaser when invoiced.

PRICING TERMS
Prices quoted are FCA surface point of shipment, with freight included to an accessible point nearest
the jobsite. Federal, state or local sales, use or other taxes are not included in the sales price.

PAYMENT TERMS
Payment terms are:

Ten percent (10%) net cash after submittal and
Eighty percent (80%) net cash upon shipment of major Product items; and

Ten percent (10%) upon the earlier of (a) Product startup and (b) one hundred eighty (180) days after
completion of shipment.

Credit is subject to acceptance by the Ovivo Credit Department.

Purchaser shall remit payment for proper invoices received from Ovivo in accordance with the
payment terms stated above even if the Purchaser has not been paid by the Purchaser’s customer

Ovivo USA, LLC | 4246 Riverboat Road, Suite 300, Salt Lake City, Utah 84123 USA | Tel: (801) 931-3000 | Fax: (801) 931-3080
ovivowater.com



TAXES

(the “Owner”), if Purchaser is not the end-user of the Products. Payments are due within thirty (30)
days after Purchaser’s receipt of invoice. Overdue and unpaid invoices are subject to a service charge
of 2% per month until paid.

If Purchaser requests or causes cancellation, suspension or delay of Ovivo’s work, Purchaser shall
accept transfer of title and pay Ovivo all appropriate charges incurred up to date of such event plus
Ovivo’s overhead and reasonable profit. Additionally, all charges related to and risks incidental to
storage, disposition and/or resumption of work shall be borne solely by Purchaser. Full payment for
all work shall be due and payable thirty (30) days from the date work is placed into storage.

Federal, State or local sales, use or other taxes are not included in the sales price. Such taxes, if
applicable, shall be for Purchaser's account.

BACKCHARGES

In no event shall Purchaser/Owner do or cause to be done any work, purchase any services or
material or incur any expense for the account of Ovivo, nor shall Ovivo be responsible for such work
or expenses, until after Purchaser/Owner has provided Ovivo’s PROJECT MANAGER full details
(including estimate of material cost and amount and rate of labor required) of the work, services,
material or expenses, and Ovivo has approved the same in writing. Ovivo will not accept Products
returned by Purchaser/Owner unless Ovivo has previously accepted the return in writing and
provided Purchaser/Owner with shipping instructions.

**PURCHASE ORDER SUBMISSION**

In an effort to ensure all purchase orders are processed timely and efficiently, please submit all
purchase order documentation to the following department and address:

Attn: Order Entry Administrator

Ovivo USA, LLC

4246 Riverboat Road, Suite 300
Salt Lake City, Utah 84123

Fax #: 801-931-3080
Tel. #: 801-931-3000

Ovivo USA, LLC | 4246 Riverboat Road, Suite 300, Salt Lake City, Utah 84123 USA | Tel: (801) 931-3000 | Fax: (801) 931-3080
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ADDITIONAL FIELD SERVICE
When included and noted in the Product pricing of each proposal item, Ovivo will supply the service of a

competent field representative to inspect the completed installation and adjustment of equipment,
supervise initial operation, and instruct Owner's personnel in the operation and maintenance of each
proposal item for the number of eight (8) hour days. Notwithstanding Ovivo’s performance of the above-
referenced services, Ovivo shall not be held liable for any faulty workmanship or other defects in the
Products’ installation, or for other goods and/or services, performed by third parties unless such goods
and/or services are expressly included under Ovivo's scope of work.

If additional service is required, it will be furnished to the Purchaser and billed to him at the current rate
for each additional day required, plus travel and lodging expenses incurred by the service personnel during
the additional service days.

it shall be the Purchaser's responsibility to provide for all necessary lubrication of all equipment prior to
placing equipment in operation. All equipment must be in operating condition and ready for the Field
Service Engineer when called to the project location. Should the Purchaser/Owner not be ready when the
Field Service Engineer is requested or if additional service is requested, the Ovivo current service rates will
apply for each additional day required, plus travel and lodging expenses incurred by the service personnel
during the additional service days.

SURFACE PREPARATION AND PAINTING GENERAL INFORMATION

If painting the Products is included under Ovivo’s scope of work, such Products shall be painted in
accordance with Ovivo’s standard practice. Shop primer paint is intended to serve only as minimal
protective finish. Ovivo will not be responsible for condition of primed or finished painted surfaces after
equipment leaves its shops. Purchasers are invited to inspect painting in our shops for proper preparation
and application prior to shipment. Ovivo assumes no responsibility for field service preparation or touch-
up of shipping damage to paint. Painting of fasteners and other touch-up to painted surfaces will be by
Purchaser's painting contractor after mechanism erection.

Clarifier motors, gear motors and center drives shall be cleaned and painted with manufacturer's standard
primer paint only.

It is our intention to ship major steel components as soon as fabricated, often before drives, motors and
other manufactured components. Unless you can insure that shop primed steel shall be field painted
within thirty (30) days after arrival at the jobsite, we encourage you to purchase these components in the
bare metal (no surface prep or primer) condition.

Ovivo cannot accept responsibility for rusting or deterioration of shop applied prime coatings on delivered
equipment if the primed surfaces have not been field painted within thirty (30) days of arrival at the jobsite
using manufacturers' standard primers. Other primers may have less durability.

Ovivo USA, LLC | 4246 Riverboat Road, Suite 300, Salt Lake City, Utah 84123 USA | Tel: (801) 931-3000 | Fax: (801) 931-3080

ovivowater.com

PROPOSAL | 1-54-0052 REV 2 | 7June 19 | Page 7



PROPOSAL | 1-54-0052 REV 2 | 7 June 19 | Page 8

PRICE ESCALATION
The prices submitted are based upon Purchaser’s acceptance of this proposal by July 10, 2019.
If the above indicated order date is exceeded, prices and shipping dates are subject to review and
adjustment. Should shipment dates be exceeded because of actions of parties other than by Ovivo,
escalation of the selling prices at the rate of 1.5% per month for each month or partial month of delay
will be applied. This escalation will be applied only if shipment is delayed by actions of parties other
than by Ovivo.

GENERAL ITEMS NOT INCLUDED
Unless specifically and expressly included above, prices quoted by Ovivo do not include unloading,

hauling, erection, installation, piping, valves, fittings, stairways, ladders, walkways, grating, wall
spools, concrete, grout, sealant, dissimilar metal protection, oakum, mastic, field painting, oil or
grease, electrical controls, wiring, mounting hardware, welding, weld rod, shims, leveling plates,
protection against corrosion due to unprotected storage, special engineering, or overall plant or
system operating instructions or any other products or services.

Performance and payment security, including but not limited to bonds, letters of credit, or bank
guarantees, are not included, but can be provided if purchased for an additional cost.

MANUALS
The content of any and all installation, operation and maintenance or other manuals or documents
pertaining to the Products are copyrighted and shall not be modified without the express prior
written consent of Ovivo. Ovivo disclaims any liability for claims resulting from unauthorized
modifications to any such manuals or other documents provided by Ovivo in connection with the
Project.

WARRANTY AND CONDITIONS
Ovivo standard Terms and Conditions of Sale, QFORMEWT 0115-02031 is attached and made an

essential part of this proposal. These terms and conditions are an integral part of Ovivo's offer of
Products and related services and replace and supersede any terms and conditions or warranty
included in Purchaser or Owner requests for guotation or specifications and cannot be changed
without written approval from an authorized representative of Ovivo.

CONFIDENTIALITY
The contents of this proposal are confidential and shall be used by Purchaser and/or Owner only for
the purpose of evaluating Ovivo’s offer of goods and services in connection with the Project.
Purchaser/Owner shall not disclose the contents of this proposal to any third party without the prior
written consent of Ovivo.

Attachment:
Amendment to Billings PA for Grit Trap jun7 2019

Ovivo USA, LLC | 4246 Riverboat Road, Suite 300, Satt Lake City, Utah 84123 USA | Tel: (801) 931-3000 | Fax: (801) 931-3080
ovivowater.com
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SECTION 01 33 00
SUBMITTALS

GENERAL

1.1 SUMMARY

A. Section Includes:

1.

2.

Mechanics and administration of the submittal process for:
a. Shop Drawings.

b. Samples.

c. Informational submittals.

General content requirements for Shop Drawings.

B. Related Specification Sections include but are not necessarily limited to:

1.
2.
3.
4.

Division 00 - Bidding Requirements, Contract Forms and Conditions of the Contract.
Division 01 - General Requirements.

Section 01 33 04 — Operations and Maintenance Manuals.

Section 46 23 23 — Grit Removal Equipment: Forced Vortex Type.

1.2 DEFINITIONS
A. Shop Drawings:

1.
2.

See General Conditions.
Product data and samples are Shop Drawing information.

B. Informational Submittals:

1.

2.

Submittals other than Shop Drawings and samples required by the Contract Documents that
do not require review and/or approval by the Engineer.

Representative types of informational submittal items include but are not limited to:

a. Installed equipment and systems performance test reports.

b. Manufacturer's installation certification letters.

c. Warranties.

d. Service agreements.

For-Information-Only submittals upon which the Engineer is not expected to conduct
review or take responsive action may be so identified in the Contract Documents.

1.3 PREPARATION OF SUBMITTALS

A. General:
1. All submittals and all pages of all copies of a submittal shall be completely legible.
2. Submittals which, in the Engineer’s sole opinion, are illegible will be returned without
review.
3. Minimize extraneous information for equipment and products not relevant to the submittal.
4. Supplies written comments on the submittal drawings shall be in GREEN.
5. SHOP DRAWINGS ARE REQUIRED TO BE SUBMITTED ELECTRONICALLY

IN BLACK AND WHITE. COLOR ONLY TO BE USED IF REQUIRED FOR

CLARITY.

a. Maximum electronic file size is 10 megabytes for transmittal via email. Electronic files
larger than 10 megabytes can be broken up for emailing or copied onto HDR’s FTP site
or guest transfer drive with follow up by and email notice indicating delivery of the
shop drawing.

B. Shop Drawings, Product Data, and Samples:

1.

233305

Scope of any submittal and letter of transmittal:
a. Limited to one (1) Specification Section.
b. Submittals with more than one Specification section included will be rejected.

City of Billings

W.0O. 14-11: WRF Nutrient Upgrade, Expansion and ImprovementsHeadworks Grit Unit Procurement -

SUBMITTALS
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ExhibA A Yoo

c. Do not submit under any Specification Section entitled (in part) "Basic Requirements"
unless the product or material submitted is specified, in total, in a "Basic Requirements"
Specification Section.

Numbering letter of transmittal:

a. Include as prefix the Specification Section number followed by a series number, "-xx",
beginning with "01" and increasing sequentially with each additional transmittal for that
Specification Section.

b. If more than one (1) submittal under any Specification Section, assign consecutive
series numbers to subsequent transmittal letters.

Describing transmittal contents:

a. Provide listing of each component or item in submittal capable of receiving an
independent review action.

b. Identify for each item:

1) Manufacturer and Manufacturer's Drawing or data number.

2) Contract Document tag number(s).

3) Unique page numbers for each page of each separate item.

c.  When submitting "or-equal” items that are not the products of named manufacturers,
include the words "or-equal" in the item description.

Supplier’s certification of review and approval:

a. Supplier shall execute Exhibit AA, Suppliet's Submittal Certification form, to indicate
Supplier has reviewed and approved the submittal contents.

1) Clearly identify the person who reviewed the submittal and the date it was
reviewed."

b. Submittals containing multiple independent items shall be prepared with each item
listed on the letter of transmittal or on an index sheet for all items listing the discrete
page numbers for each page of each item, which shall be stamped with the Supplier's
review and approval stamp.

1) Each independent item shall have a cover sheet with the transmittal number and
item number recorded.

a) Provide clear space of 3 IN SQ for Engineer stamping.

2) Individual pages or sheets of independent items shall be numbered in a manner that
permits the entire contents of a particular item to be readily recognized and
associated with Supplier's certification.

Resubmittals:

a. Number with original Specification Section and series number with a suffix letter
starting with "A" on a (new) duplicate transmittal form.

. Do not increase the scope of any prior transmittal.

c. Provide cover letter indicating how each "B", "C", or "D" Action from previous
submittal was addressed and where the correction is found in the resubmittal.

d. Account for all components of prior transmittal.

1) Ifitems in prior transmittal received "A" or "B" Action code, list them and indicate
"A" or "B" as appropriate.

a) Do not include submittal information for items listed with prior "A" or "B"
Action in resubmittal.

2) Indicate "Outstanding-To Be Resubmitted At a Later Date" for any prior "C" or
"D" Action item not included in resubmittal.

a) Obtain Engineer's approval to exclude items.

Supplier shall not use red color for marks on transmittals.

a. Duplicate all marks on all copies transmitted, and ensure marks are photocopy
reproducible.

b. Engineer will use red marks or enclose marks in a cloud.

Transmittal contents:

a. Coordinate and identify Shop Drawing contents so that all items can be easily verified
by the Engineer.

City of Billings
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b. Provide submittal information or marks defining specific equipment or materials
utilized on the Project.

1) Generalized product information, not clearly defining specific equipment or
materials to be provided, will be rejected.

c. Identify equipment or material project use, tag number, Drawing detail reference,
weight, and other Project specific information.

d. Provide sufficient information together with technical cuts and technical data to allow
an evaluation to be made to determine that the item submitted is in compliance with the
Contract Documents.

e. Do not modify the manufacturer's documentation or data except as specified herein.

f.  Submit items such as equipment brochures, cuts of fixtures, product data sheets or
catalog sheets not exceeding 11 x 17 IN pages.

1) Indicate exact item or model and all options proposed by arrow and leader.

g.  When a Shop Drawing submittal is called for in any Specification Section, include as
appropriate, scaled details, sizes, dimensions, performance characteristics, capacities,
test data, anchoring details, installation instructions, storage and handling instructions,
color charts, layout Drawings, rough-in diagrams, wiring diagrams, controls, weights
and other pertinent data in addition to information specifically stipulated in the
Specification Section.

1) Arrange data and performance information in format similar to that provided in
Contract Documents.

2) Provide, at minimum, the detail specified in the Contract Documents.

h. If proposed equipment or materials deviate from the Contract Drawings or
Specifications in any way, clearly note the deviation and justify the said deviation in
detail in a separate letter immediately following transmittal sheet. Any deviation from
plans or specifications not depicted in the submittal or included but not clearly noted by
the Supplier may not have been reviewed. Review by the Engineer shall not serve to
relieve the Supplier of the contractual responsibility for any error or deviation from
contract requirements.

8. Samples:

a. ldentification:

1) Identify sample as to transmittal number, manufacturer, item, use, type, project
designation, tag number, Specification Section or Drawing detail reference, color,
range, texture, finish and other pertinent data.

2) Ifidentifying information cannot be marked directly on sample without defacing or
adversely altering samples, provide a durable tag with identifying information
securely attached to the sample.

. Include application specific brochures, and installation instructions.

¢. Provide Supplier's review and approval certification stamp or Supplier's Submittal
Certification form as indication of Supplier's checking and verification of dimensions
and coordination with interrelated work.

d. Resubmit revised samples of rejected items.

C. Informational Submittals:
1. Prepare in the format and detail specified in Specification requiring the informational
submittal.

1.4 TRANSMITTAL OF SUBMITTALS

A. Shop Drawings and Samples:
1. Transmit all submittals to:
2. Craig Habben: craig.habben@hdrinc.com
3. Utilize two (2) copies of attached Exhibit A to transmit all Shop Drawings and samples.

B. Informational Submittals:
1. Transmit under Supplier's standard letter of transmittal or letterhead.

233305 City of Billings
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2.
3.

Txhbit A T4

Submit in triplicate or as specified in individual Specification Section.
Transmit to:

C. Electronic Transmission of Submittals:

1.

(AmEpty) 1D

10.

11.

12.

13.

Transmittals shall be made electronically.

a. Use email.

Provide documents in Adobe Acrobat Portable Document Format (PDF), latest version.

Create one (1) PDF file for each equipment Operation and Maintenance Manual.

Do not password protect or lock the PDF document.

Drawings or other graphics must be converted to PDF file format from the original drawing

file format and made part of the PDF document.

a. Scanning of drawings is to be used only where actual file conversion is not possible and
drawings must be scanned at a resolution of 300 dpi or greater.

b. Required signatures may be applied prior to scanning for transmittal.

Electronic drawings shall be formatted to be at full-scale (or half-scale when printed to

11x17).

a. Do not reduce drawings by more than 50% in size.

b. Reduced drawings shall be clearly marked "HALF-SIZE" and shall scale accurately at
that size.

Rotate sheets that are normally viewed in landscape mode so that when the PDF file is

opened the sheet is in the appropriate position for viewing.

Create bookmarks in the bookmarks panel for the Operation and Maintenance Manual

cover, the Table of Contents and each major section of the Table of Contents.

Using Adobe Acrobat Standard or Adobe Acrobat Professional, set the PDF document

properties, initial view as follows:

Select File > Properties—>Initial View.

Select the Navigation tab: Bookmarks Panel and Page.

Select the Page layout: Single Page.

Select the Magnification: Fit Page.

Select Open to page: 1.

Set the file to open to the cover page with bookmarks to the left, and the first bookmark

linked to the cover page.

Set the PDF file "Fast Web View" option to open the first several pages of the document

while the rest of the document continues to load.

a. Todo this:

1) Select Edit>Preferences—> Documents—> Save Settings.
2) Check the Save As optimizes for Fast Web View box.

File naming conventions:

a. File names shall use a "ten dot three" convention (XXXXXX-YY-Z.PDF) where
XXXXXX is the Specification Section number, YY is the Shop Drawing Root number
and Z is an ID number used to designate the associated volume.

Labeling:

a. Asa minimum, include the following labeling on all CD-ROM discs and jewel cases:
1) Project Name.

2) Equipment Name and Project Tag Number.
3) Project Specification Section.

4) Manufacturer Name.

5) Vendor Name.

Binding:

a. Include labeled CD(s) in labeled jewel case(s).

1) Bind jewel cases in standard three-ring binder Jewel Case Page(s), inserted at the
front of the Final paper copy submittal.

2) Jewel Case Page(s) to have means for securing Jewel Case(s) to prevent loss (e.g.,
flap and strap).

e Ao T
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1.5 ENGINEER'S REVIEW ACTION
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A. Shop Drawings and Samples:

1.

Items within transmittals will be reviewed for overall design intent and will receive one (1)

of the following actions:

a. A -FURNISH AS SUBMITTED.

b. B-FURNISH AS NOTED (BY ENGINEER).

¢. C-REVISE AND RESUBMIT.

d. D-REJECTED.

e. E-ENGINEER'S REVIEW NOT REQUIRED.

Submittals returned with Action "A" or "B" are considered ready for fabrication and

installation.

a. If for any reason a submittal that has an "A" or "B" Action is resubmitted, it must be
accompanied by a letter defining the changes that have been made and the reason for
the resubmittal.

b. Destroy or conspicuously mark "SUPERSEDED" all documents having previously
received "A" or "B" Action that are superseded by a resubmittal.

Submittals with Action "A" or "B" combined with Action "C" (Revise and Resubmit) or

"D" (Rejected) will be individually analyzed giving consideration as follows:

a. The portion of the submittal given "C" or "D" will not be distributed (unless previously
agreed to otherwise at the Preconstruction Conference).

1) One (1) copy or the one (1) transparency of the "C" or "D" Drawings will be
marked up and returned to the Supplier.
a) Correct and resubmit items so marked.

Items marked "A" or "B" will be fully distributed.

c. [Ifaportion of the items or system proposed are acceptable, however, the major part of
the individual Drawings or documents are incomplete or require revision, the entire
submittal may be given "C" or "D" Action.

1) This is at the sole discretion of the Engineer.

2) In this case, some Drawings may contain relatively few or no comments or the
statement, "Resubmit to maintain a complete package."

3) Distribution to the Owner and field will not be made (unless previously agreed to
otherwise).

Failure to include any specific information specified under the submittal paragraphs of the

Specifications will result in the submittal being returned to the Supplier with "C" or "D"

Action.

Calculations required in individual Specification Sections will be received for information

purposes only, as evidence calculations have been stamped by the professional as defined in

the specifications and for limited purpose of checking conformance with given performance
and design criteria. The Engineer is not responsible for checking the accuracy of the
calculations and the calculations will be returned stamped "E. Engineer's Review Not

Required" to acknowledge receipt.

Supplier shall furnish required submittals with sufficient information and accuracy to obtain

required approval of an item with no more than three submittals. Engineer will record

Engineer’s time for reviewing a fourth or subsequent submittal of a Shop Drawings, sample,

or other item requiring approval, and Supplier shall be responsible for Engineer’s charges to

Owner for such time. Owner may impose a set-off against payments due to Supplier to

secure reimbursement for such charges.

Transmittals of submittals which the Engineer considers as "Not Required” submittal

information, which is supplemental to but not essential to prior submitted information, or

items of information in a transmittal which have been reviewed and received "A" or "B"

action in a prior submittal, will be returned with action "E. Engineer's Review Not

Required.”

Samples may be retained for comparison purposes.

a. Remove samples when directed.

City of Billings
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b. Include in bid all costs of furnishing and removing samples.
9. Approved samples submitted or constructed, constitute criteria for judging completed work.
a. Finished work or items not equal to samples will be rejected.

PART 2 - PRODUCTS - (NOT APPLICABLE TO THIS SPECIFICATION SECTION)

PART 3 - EXECUTION - (NOT APPLICABLE TO THIS SPECIFICATION SECTION)

233305

END OF SECTION
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=XHIBITA - Shop Drawing Transmittal No.

(Spec Section) (Series)
Project Name: Date Received:
Project Owner: (Checked By:
Supplier: HDR Engineering, Inc. Log Page:
[Address: Address: HDR No.:
Spec Section:
Drawing/Detail No.:
Attn: Attn: 1st. Sub ReSub.
Date Transmitted: Previous Transmittal Date:
Item| No. Description Manufacturer Mfr/Vendor Dwg or Data No.|  Action Taken*
No. | Cople
S
Remarks:
" The Action designated above is in accordance with the following legend:
A - Furnish as Submitted E - Engineer's review not required
i} ; 1. Submittal not required.
B Furn.lsh e ) 2. Supplemental Information. Submittal retained for informational purposes only.
C - Revise and Submit ) 3. Information reviewed and approved on prior submittal.
. Not enoggh information for 4. See comments.
review. ) 5. Delegated Design - Submittal received as requested by the Contract
2. No reproducibles submitted. Documents. The Engineer did not review the engineering or technical content
3. Copies illegible. of the submittal.
4. Not enough copies [ i ) -
submitted. Engineer's review and approval will be only to determine if the items covered by the submittals
5. Wrong sequence number. will, after installation or incorporation in the Work, conform to the information given in the
6. Wrong resubmittal number. Contract Documents and be compatible with the design concept of the completed Project as a
7. Wrong spec. section. functioning whole as indicated by the Contract Documents. Any deviation from plans or
8. Wrong form used. pecifications not depicted in the submittal or included but not clearly noted by the Supplier
9. See comments. ay not have been reviewed. Review by the Engineer shall not serve to relieve the Supplier of
D - Rejected e contractual responsibility for any error or deviation from contract requirements.
Comments:
By Date
Distribution; Supplier | | File| | Field| | Owner| | Other|
Copyright 1991-2013 HDR Engineering, Inc. - Revised July 2014
233305 City of Billings
W.0O. 14-11: WRF Nutrient Upgrade, Expansion and ImprovementsHeadworks Grit Unit Procurement -
SUBMITTALS
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EXHIBIT AA Supplier's Submittal
Certification

Shop Drawing Transmittal No.:

Contract/Project Name:

Company Name:

has

1. reviewed and coordinated this Shop Drawing or Sample with other Shop Drawings and Samples and
with the requirements of the Work and the Contract Documents;

2. determined and verified all field measurements, quantities, dimensions, specified performance and
design criteria, installation requirements, materials, catalog numbers, and similar information with
respect thereto;

3. determined and verified the suitability of all materials offered with respect to the indicated application,
fabrication, shipping, handling, storage, assembly, and installation pertaining to the performance of the
Work; and

4. determined and verified all information relative to Supplier's responsibilities for means, methods,

techniques, sequences, and procedures of construction, and safety precautions and programs incident
thereto.

O This Submittal does not contain any variations from the requirements of the Contract Documents.

O This Submittal does contain variations from the requirements of the Contract Documents. A separate
description of said variations and a justification for them is provided in an attachment hereto identified
as:

"Shop Drawing Transmittal No. Variation and Justification
Documentation"

Insert picture file or electronic signature of Authorized

Representative

Authorized Representative Date

Copyright 1991-2013 HDR Engineering, Inc. - Revised Oct 2011

233305
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SECTION 01 33 04
OPERATION AND MAINTENANCE MANUALS

PART 1 - GENERAL
1.1 SUMMARY
A. Section Includes:
1. Administration of the submittal process for Operation and Maintenance Manuals.
2. Content requirements for Operation and Maintenance Manuals.

1.2

1.3

1.4

1.5

233305

B. Related Specification Sections include but are not necessarily limited to:

1. Section 01 33 00 — Submittals.
2. Section 46 23 23 — Grit Removal Equipment: Forced Vortex Type.
DEFINITIONS

A. Equipment Operation and Maintenance Manuals:

1. Contain the technical information required for proper installation, operation and
maintenance of process, electrical and mechanical equipment and systems.
SUBMITTALS

A. Operation and Maintenance Manuals:

1. Draft and final electronic copies.
2. Final paper copies: Two (2).
SUBMITTAL SCHEDULE

A. Draft Operation and Maintenance Manuals:

1.

Submit approvable draft manuals in electronic format (PDF) within 30 days following

approval of the respective Shop Drawing.

a. Include placeholders or fly sheet pages where information is not final or is missing
from the draft manual.

B. Final Operation and Maintenance Manuals:

1.

2.

3.

Final approval of Operation and Maintenance Manuals in electronic format (PDF) must be
obtained 45 days prior to equipment start-up.

Provide paper copies and CD-ROMs of approved final Operation and Maintenance Manuals
in electronic format (PDF), a minimum of 30 days prior to equipment start-up.

Issue addenda to Final Approved Operation and Maintenance Manual to include:

a. Equipment field testing data.

b. Equipment start-up reports.

PREPARATION OF SUBMITTALS

A. General:

1. All pages of the Operation and Maintenance Manual submittal shall be legible.

a. Submittals which, in the Engineer’s sole opinion, are illegible will be rejected without
review.

2. Identify each equipment item in a manner consistent with names and identification numbers
used in the Contract Documents, not the manufacturer’s catalog numbers.

3. Neatly type any data not furnished in printed form.

4. Operation and Maintenance Manuals are provided for Owner's use, to be reproduced and

distributed as training and reference materials within Owner's organization.
a. This requirement is:
1) Applicable to both paper copy and electronic files.
2) Applicable to materials containing copyright notice as well as those with no
copyright notice.

City of Billings
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5.
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Notify supplier and/or manufacturer of the intended use of Operations and Maintenance
Manuals provided under the Contract.

B. Operation and Maintenance Manual Format and Delivery:
Draft electronic submittals:

1.

a.

b.
c.
d

b.

Provide manual in Adobe Acrobat Portable Document Format (PDF), latest version.
Create one (1) PDF file for each equipment Operation and Maintenance Manual.
Do not password protect or lock the PDF document.
Drawings or other graphics must be converted to PDF file format from the original
drawing file format and made part of the PDF document.
Scanning of drawings is to be used only where actual file conversion is not possible and
drawings must be scanned at a resolution of 300 dpi or greater.
Rotate sheets that are normally viewed in landscape mode so that when the PDF file is
opened the sheet is in the appropriate position for viewing.
Create bookmarks in the bookmarks panel for the Operation and Maintenance Manual
cover, the Table of Contents and each major section of the Table of Contents,
Using Adobe Acrobat Standard or Adobe Acrobat Professional, set the PDF document
properties, initial view as follows:
1) Select File > Properties>Initial View.
2) Select the Navigation tab: Bookmarks Panel and Page.
3) Select the Page layout: Single Page.
4) Select the Magnification: Fit Page.
5) Select Open to page: 1.
6) Set the file to open to the cover page of the manual with bookmarks to the left, and
the first bookmark linked to the cover page.
Set the PDF file "Fast Web View" option to open the first several pages of the
document while the rest of the document continues to load.
1) To do this:
a) Select Edit->Preferences> Documents—=> Save Settings.
b) Check the Save As optimizes for Fast Web View box.
PDF file naming convention:
1) Use the Specification Section number, the manufacturer’s name and the equipment
description, separated by underscores.
2) Example: 46 51 21 Sanitaire_Coarse Bubble Diffusers.pdf.
3) Do not put spaces in the file name.

Final electronic submittals:
a.

Submit two (2) copies in PDF file format on two (2) CD-ROM discs (one (1) copy per
CD-ROM), each secured in a jewel case.
CD-ROM Labeling:
1) Provide the following printed labeling on all CD-ROM discs:
a) Project name.
b) Specification Section.
c¢) Equipment names and summary of tag(s) covered.
d) Manufacturer name.
e) Date (month, year).
CD-ROM Jewel Case Holder:
1) Insert jewel cases containing labeled CD-ROM discs in three-ring binder holder
(C-Line Products, www.c-lineproducts.com stock number CLI-61968 or
equivalent) at the front of each final paper copy.

Final paper copy submittals:

a.
b.

Quantity: Provide two (2) copies.

Paper: 8.5x 11 INor 11 x 17 IN bright white, 20 pound paper with standard three-hole
punching.

3-Ring Binder:

1) Provide D-ring binder with clear vinyl sleeves (i.e. view binder) on front and spine.

City of Billings
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2) Insert binder title sheet with the following information under the front and spine
sleeves:
a) Project name.
b) Specification Section.
¢) Equipment names and summary of tag(s) covered.
d) Manufacturer name.
e) Date (month, year).
3) Provide plastic sheet lifters prior to first page and following last page.
d. Drawings:
1) Provide all drawings at 11 x 17 IN size, triple folded and three-hole punched for
insertion into manual.
2) Where reduction is not practical to ensure readability, fold larger drawings
separately and place in three-hole punched vinyl envelopes inserted into the binder.
3) Identify vinyl envelopes with drawing numbers,
e. Use plastic coated dividers to tab each section of each manual in accordance with the
Table of Contents.

C. Equipment Operation and Maintenance Manual Content:

1.

Provide a cover page as the first page of each manual with the following information:

Manufacturer(s) Name and Contact Information.

Vendor’s Name and Contact Information.

Date (month, year).

Project Owner and Project Name.

Specification Section.

Project Equipment Tag Numbers.

Model Numbers.

. Engineer’s Name.

Provide a Table of Contents for each manual.

Provide Equipment Record sheets as follows:

a. Printed copies of the Equipment Record (Exhibits B1, B2 and B3), as the first tab
following the Table of Contents.

b. Exhibits B1-B3 are available as Fillable PDF Form documents from the Engineer.

¢. Each section of the Equipment Record must be completed in detail; simply referencing
the related equipment Operation and Maintenance Manual sections for nameplate,
maintenance, spare parts or Jubricant information is not acceptable.

d. For equipment involving separate components (for example, a motor and gearbox), a
fully completed Equipment Record is required for each component.

e. Submittals that do not include the Equipment Record(s) will be rejected without further
content review.

Provide a printed copy of the Manufacturer’s Field Services report following the Equipment

Record sheets.

Provide the following detailed information, as applicable:

a. Use equipment tag numbers from the Contract Documents to identify equipment and
system components.

Equipment function, normal and limiting operating characteristics.

c. Instructions for assembly, disassembly, installation, alignment, adjustment, and
inspection.

d. Operating instructions for start-up, normal operation, control, shutdown, and
emergency conditions.

e. Lubrication and maintenance instructions.

f.  Troubleshooting guide.

g. Mark each sheet to clearly identify specific products and component parts and data
applicable to the installation for the Project; delete or cross out information that does
not specifically apply to the Project.

h. Parts lists:

1) A parts list and identification number of each component part of the equipment.

SR Mo oo o
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2) Exploded view or plan and section views of the equipment with a detailed parts
callout matching the parts list.

3) A list of recommended spare parts.

4) List of spare parts provided as specified in the associated Specification Section.

5) A list of any special storage precautions which may be required for all spare parts.

General arrangement, cross-section, and assembly drawings.

—_—

j-  Electrical diagrams, including elementary diagrams, wiring diagrams, connection
diagrams, and interconnection diagrams.

k. Test data and performance curves,

. As-constructed fabrication or layout drawings and wiring diagrams.

m. Copy of the equipment manufacturer’s warranty meeting the requirements of the

Contract.
n. Copy of any service contracts provided for the specific piece of equipment as part of
the Contract.
6. Additional information as required in the associated equipment or system Specification
Section.

1.6 TRANSMITTAL OF SUBMITTALS

A.

Operation and Maintenance Manuals.
1. Transmit all submittals to:

a. The address specified in Specification Section 01 33 00 - SUBMITTALS.

2. Transmittal form: Use Operation and Maintenance Manual Transmittal, Exhibit A.
3. Transmittal numbering:

a. Number each submittal with the Specification Section number followed by a series
number beginning with "-01" and increasing sequentially with each additional
transmittal, followed by "-OM" (for example: 46 23 23-01-OM).

4. Submit draft and final Operation and Maintenance Manual in electronic format (PDF) to

Engineer, until manual is approved.

1.7 ENGINEER'S REVIEW ACTION

A.

B.

233305

Draft Electronic (PDF) Submittals:

1. Engineer will review and indicate one of the following review actions:
a. A -ACCEPTABLE
b. B -FURNISH AS NOTED
c. C-REVISE AND RESUBMIT
d. D-REJECTED

2. Submittals marked as Acceptable or Furnish As Noted will be retained; however, the
transmittal form will be returned with a request for the final paper and electronic documents
to be submitted.

3. Copies of submittals marked as Revise and Resubmit or Rejected will be returned with the
transmittal form marked to indicate deficient areas.

4. Resubmit until approved.

Final Paper Copy Submittals:

1. Engineer will review and indicate one (1) of the following review actions:
a. A-ACCEPTABLE
b. D-REJECTED

2. Submittals marked as Acceptable will be retained with the transmittal form returned as
noted.

3. Submittals marked as Rejected will be returned with the transmittal form marked to indicate
deficient areas.

4. Resubmit until approved.

City of Billings
W.0. 14-11: WRF Nutrient Upgrade, Expansion and ImprovementsHeadworks Grit Unit Procurement -
OPERATION AND MAINTENANCE MANUALS
013304-4
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PART 2 - PRODUCTS - (NOT APPLICABLE TO THIS SPECIFICATION SECTION)

PART 3 - EXECUTION - (NOT APPLICABLE TO THIS SPECIFICATION SECTION)

END OF SECTION

233305 City of Billings
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EXHIBITA Qperation and Maintenance Manual
Transmittal - - OM

{Spec Section) (Series)

Project Name: Date Received:
Project Owner: Checked By:
Supplier: Owner: Log Page:
Address: Address: HDR No.:
Attn: Attn:
1st, Sub. ReSub.
Date Transmitted: Previous Transmittal Date:
No. Description of Item Manufacturer Dwg. or Data No. Action Taken*
Copies
Remarks:
To: From:

HDR Engineering, Inc.

Date:

*

The Action designated above is in accordance with the following legend:
A - Acceptable

B - Furnish as Noted

C - Revise and Resubmit

D - Rejected
Comments:

By Date
Distribution: Supplier | | Fie | | Field | | Owner | | Other | |

{Jun 1990; Revised Oct 2001, Revised Nov 2007, Revised 2013) Copyright 1991-2014 HDR Engineering, Inc.

DN =
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EXHIBIT B1

Equipment Data and Spare Parts Summary

Equipment Record

Project Name

Equipment Name

Project Equipment Tag No(s).

Equipment Manufacturer iProject/
rder No.
Address Phone

E-mail

Fax ’Web Site

Local Vendor/Service Center

Address

Fax IWeb Site ‘.E-mail

MECHANICAL NAMEPLATE DATA

Equip- | sertal No.
Make [ Mode! No.
1D No. Frame No. HP RPM Cap.
Size TDH Imp. Sz. CFM PSi
Other:
ELECTRICAL NAMEPLATE DATA
Equip. ISeriaI No.
Make |Model No.
ID No. Frame No. HP 2 Amp. HZ PH RPM ISF
Duty Code Ins. Cl. Type NEMA C Amb. Temp. Rise Rating
Other:
SPARE PARTS PROVIDED PER CONTRACT
Parl No. Part Name Quantity
RECOMMENDED SPARE PARTS
Part No. Part Name Quantity

(Jun 1990; Revised Oct 2001, Revised Nov 2007, Revised 2013) Copyright 1991-2014 HDR Engineering, Inc.

233305 City of Billings

W.O. 14-11: WRF Nutrient Upgrade, Expansion and ImprovementsHeadworks Grit Unit Procurement -

OPERATION AND MAINTENANCE MANUALS
013304 - EXHIBIT B1- 1



w

Bhibit b 7T,
EXHIBIT B2 Equipment Record

Recommended Maintenance Summary

Equipment Description Project Equip. Tag No(s),
INITIAL COMPLETION *
FOLLOWING START-UP
RECOMMENDED BREAK-IN MAINTENANCE (FIRST OIL CHANGES, ETC.) D|W[M|Q|S|A|RT| Hours
PM TASK INTERVAL *
RECOMMENDED PREVENTIVE MAINTENANCE D|W|M|Q|S|A|RT| Hours
* D= Daily W = Weekly M = Monthly Q = Quarterly 8 = Semiannual A = Annual Hours = Run Time |

(Jun 1990; Revised Ocl 2001, Revised Nov 2007, Revised 2013) Copyright 1991-2014 HDR Engineering, Inc.
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EXHIBIT B3 Equipment Record

Lubrication Summary
Equipment Description |Pro}ect Equip. Tag No(s).

lLubricant Point

Manufacturer Product AGMA # SAE # 1ISO

Lubricant Type
slw|p]=

5

Lubricant Point

Manufacturer Product AGMA # SAE # ISO

Lubricant Type

1
2
3
4

5

lLubricant Point

Manufacturer Product AGMA # SAE # ISO

Lubricant Type
rlw|n| =

Lubricant Point

Manufacturer Product AGMA # SAE # 1SO

Lubricant Type
AlwlNDp| -~

5

_ubricant Point

Manufacturer Product AGMA # SAE # 1SO

Lubricant Type
rlwlro]|

5

i_ubricant Point

Manufacturer Product AGMA # SAE # 1SO

Lubricant Type
Alow|n| =

5

(Jun 1890; Revised Oct 2001, Revised Nov 2007, Revised 2013) Copyright 1991-2014 HDR Engineering, Inc.
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SECTION 46 23 23
GRIT REMOVAL EQUIPMENT: FORCED VORTEX TYPE

PART 1 - GENERAL

1.1 SUMMARY

A. Section Includes:
1. Circular forced vortex type grit removal equipment,
a. Contract Drawings provide general layout of units. Supplier to provide detailed drawings
for units to meet the performance requirements of this specification.
2.  Grit removal pumping unit.

B. The equipment specified herein is intended to be identical to existing equipment currently in
operation at the Billings Water Reclamation Facility. All components of the new equipment shall be
identical to existing equipment unless specifically noted by the supplier and approved by the
engineer during the Shop Drawing phase prior to equipment fabrication and delivery. Owner
reserves the right to install existing spare part inventory on new equipment to verify compatibility at
their discretion. In the event existing spare part components are not compatible with new equipment,
supplier will provide new, matching equipment, at no additional cost to the Owner.

C. Related Sections include but are not necessarily limited to:
1. Section 01 33 00 — Submittals.
2. Section 01 33 04 — Operations and Maintenance Manuals.

1.2 QUALITY ASSURANCE

A. Referenced Standards:
1. Anti-Friction Bearing Manufacturers Association (AFBMA).
2. American Iron and Steel Institute (AISI).
3. American Society for Testing and Materials (ASTM):
a. A36, Specification for Structural Steel.
American Society of Mechanical Engineers (ASME).
American Gear Manufacturer's Association (AGMA).
National Electrical Manufacturers Association (NEMA).
American National Standards Institute (ANSI).

1.3 SUBMITTALS

S S

A. See Section 01 33 00.

B. Shop Drawings:
1. Product technical data including:
a. Acknowledgement that products submitted meet the requirements of the standards
referenced.

b. Sufficient data to verify compliance with specifications and to illustrate construction or
assembly of the components and materials.
Manufacturer, model, and type.
Overall dimensions and total weights of equipment.
Material specifications.
Electrical wiring diagrams.
Installation drawings and layouts to scale customized for this installation.
Supplier's instruction for storage, handling and installation.
Paint product data.

T ER e a0

C. Maintenance Materials.

233305 City of Billings
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Certification of proper installation and satisfactory operation form manufacturer,

Manufacturer's field service report.

Operation and Maintenance Manuals:

1.

See Section 01 33 04.

1.4 JOB CONDITIONS

A. Provide equipment to meet area classification of Class I, Division 2.

PART 2 -

PRODUCTS

2.1 ACCEPTABLE MANUFACTURERS

A. Acceptable manufacturers:

1.

Ovivo.

2.2 MATERIALS

A. Grit Removal Equipment HWB-GRTRP-4:

1.

= 2

hORCS Tl (Shmih

Steel plate: ASTM A36.

Housing: Cast Iron, ASTM A48, Class 25 or better.

Impellers or propellers: 304L stainless steel.

Gears and pinions: Alloy steel, heat treated, machined, and hardened in accordance with AGMA
standards.

Bolts and fasteners: Stainless steel, IFI-104, Grade 303 or 305.

Anchor bolts: Stainless steel, IFI-104, Grade 303 or 305.

Drive tube and air bell: 304L stainless steel.

Influent baffle plate: 304L stainless steel.

Two piece floor plate assembly: 304L stainless steel.

B. Grit removal pump HWB-PUMP-GRTP-4:

SOR) N T o 2 8D =

— \O

I1.

4” vertical, vacuum primed type, or self-priming type.

Curved 5-vane flow inducer.

Vertical suction line.

Heavy cast iron or Ni-Hard construction.

Impeller: Ni-Hard, designed for use of mechanized seals and vacuum priming,.

Shaft: Stainless steel, no removable shaft sleeves.

Seal: Carbon and ceramic materials.

Pump motor: Vertical, solid shaft, TEFC NEMA P-base, squirrel-cage induction type, suitable
for 3 phase 60 cycle, 460 volt electric current, and class F insulation.

Eyes or Lugs: Each capable of supporting entire weight of motor and pump.

. Reprime Performance: Include provisions for the pump to remain primed and/or for automatic

reprime of the pump. Manufacturer to coordinate with contractor to insure all provisions are
included in the bid. Consideration shall be given to the sanitary sewage service anticipated, in
which debris is expected to lodge between the suction check valve and its seat, resulting in the
loss of the pump suction leg, and siphoning of liquid from the pump casing to the approximate
center line of the impeller. Such occurrence shall be considered normal, and the pump must be
capable of automatic, unattended operation.

During unattended operation, the pump shall retain adequate liquid in the casing to insure
automatic repriming while operating at its rated speed in a completely open system.

2.3 EQUIPMENT

A. Performance and Design Requirements:

1.

233305

Grit removal equipment HWB-GRTRP-4:
a. Trap chamber diameter (minimum): 16 FT - 0 IN.
b. Trap chamber depth: See Drawings.
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Grit storage chamber diameter: 5 FT - 0 IN.

Grit storage chamber depth: See Drawings.

Grit chamber elevations:

1) Operating walkway: 3098.10 + FT.

2) Grit storage chamber floor: See Drawings.

3) Trap chamber floor: See Drawings.

4) Inlet channel invert: See Drawings.

5) OQutlet channel invert: See Drawings.

6) Water level in grit basin at 20 mgd: See Drawings.

Flow through each grit chamber:

1) Peak design flow: 20 mgd.

2) Minimum design flow: 5 mgd.

Minimum drive horsepower: 0.5 HP.

Maximum drive horsepower: 2.0 HP.

Provide all baffles and other appurtenances required for proper operation of equipment.
Direction of flow rotation: Counter clockwise.

Maximum headloss across grit basin at peak design flow: 0.25 IN.

2. Gr1t removal pump HWB-PUMP-GRTP-4:

a.

T@E e a0

mnewopg T

Design Conditions:

1) 200 gpm.

2) 42 feet of head.

3) 70% efficiency.

Shaft through seal:

1)  1-7/8 IN Diameter.

2) Solid stainless steel.

Lower bearing to impeller distance: 6 IN maximum.
Shaft run-out: 0.003 IN maximum.

Shaft end play: Limited to bearing shake.

Shaft to motor base: 0.005 IN Maximum.
Impeller to shaft fit: Tapered.

Impeller:

1) Type: Recessed 5-Vane Turbo.

2) Material: Ni-Hard High nickel iron.

3) Shroud: Untrimmed — Full diameter.

Seal housing: Bronze.

Low pressure priming source: Behind impeller.
Fronthead to casing: One piece.

Backhead & motor adaptor: One piece.

. Upper bearing: Axially free.

Lower bearing: Locked in place.
Motor insulation: Class F.

Motor temperature rise: Class B.
Motor service factor: 1.15.
Maximum drive horsepower: 10.0 Hp.

2.4 FABRICATION

233305

A.

General:

1. Welding: Fully or partially submerged joints shall be sealed watertight by continuous welds.
2. Edge grinding: Dull all sharp projections by at least one pass of power grinder.
3. Shop painting;:

a.

Primer for all ferrous surfaces, except stainless and galvanized steel, which are subject to
submergence or splash with wastewater:

1) Ameron, "Amercoat 86."

2) Cook, "900-R-014 Vinicon Primer."

3) Koppers, "10 Vinyl Primer."

City of Billings
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B.

ikt b %%

4) Valspar, "80-R-8 Vinyl Primer."
5) Tnemec, "104."
b. Top coat with two coats of:
1) Ameron, "Amercoat 33."
2) Cook, "Vinicon MW."
3) Koppers, "10 Vinyl Primer."
4) Valspar, "80-R-8 Vinyl Primer."
5) Tnemec, "104."
c. Total shop coating, including primer, shall be at least 4.5 mils dry film thickness.
4. Field connections to be bolted. No field welding will be allowed.
5. No moving parts subject to wear or stoppage below the water surface.
6. All components designed for heavy-duty 24 hour per day service.

Impeller or propeller Assembly:

1. Impeller or propeller connected to drive tube driven by mechanical drive turntable bearing.

2.2 blades per unit minimum, affixed to drive tube by means of a two piece collar allowing
adjustment in either an upward or downward position to assure maximum grit removal and organics
separation.

2. Pitch of each impeller or propeller blade set.

3. Drive tube: 3/8 IN thick, minimum.

4. TImpeller or propeller blades: 1/4 IN thick, minimum.

Gear Motor:

1. Helical gear type motor, 230/460 V, 3 phase, 60 Hz, TEFC with normal starting torque and low
starting cutrent.

2. Gear reducer to include antifriction bearings with high overhung load properties, and double lip
temperature oil seals riding on precision ground shafts.

3. Gear motor designed for heavy duty 24 hour service and not to overload under any normal
operating conditions.

4. Oil lubrication for helical gearing.

5. B-10 bearing life: 100,000 hours minimum.

6. Service factor: 2.0 or greater.

Mechanical Drive:

1. Combination spur gear and minimum 19 IN diameter turntable bearing, totally enclosed in heavy
cast iron case, and driven by pinion on output shaft of gear motor.

2. Output speed: 21 rpm, maximum.

3. Mechanical drive assembly specifically designed for this service and installation, including any
additional weight from the stainless steel drive tube and impeller or propeller assembly
compared with manufacturers standard steel components. Clarifier drives modified to meet the
higher impeller or propeller speeds are not acceptable.

4. Gear box to be sealed with bottom opening for drive tube protected by air bell, 1/8 IN thick
minimum, to prevent water from entering the gearbox in the event of flooding.

5. Gear box oil or grease lubricated.

6. Service factor: 5.0 minimum, at standard operating speeds.

7. B-10 bearing life for turntable assembly: 175,000 hours, minimum,

8. B-10 bearing life for other drive assembly bearings: 100,000 hours, minimum.

B

1

affle Plate:
If required by manufacturer, provide baffle at inlet channel to maximize hydraulic conditions.

Floor Plate:

1. Ifrequired by manufacturer, provide removable floor plate assembly over grit storage chamber
to minimize the possibility of organic capture.

2. Provide 3 IN opening for grit to pass through to storage chamber.

Design plate in two sections with lifting loops to allow access to the grit storage chamber.

4. Plate to be 1/4 IN minimum and must support a 200 pound per square foot live load.

W

City of Billings
W.0. 14-11: WRF Nutrient Upgrade, Expansion and ImprovementsHeadworks Grit Unit Procurement -
GRIT REMOVAL EQUIPMENT: FORCED VORTEX TYPE
462323 -4



w

R N« Y T N

10

11
12

13

14
15

16
17
18
19
20
21
22
23

24

FxlibA A ﬂ/g}

G. Straightening Vanes:
1. Ifrequired by manufacturer, provide stainless steel straightening vanes in approach channel.

2.5 MAINTENANCE MATERIALS

A. Replacement lubricant for two drive gear assemblies.
B. One spare gear motor.
C. One spare pump motor.

D. One spare mechanical drive.

PART 3 - PART 3 - EXECUTION

3.1 INSTALLATION

A. By Installation Contractor to be Bid Separately.

B. See attached drawings for installation requirements in terms of below slab components fitting
through existing opening and assembly below slab.

3.2 FIELD QUALITY CONTROL

A. Manufacturer's Field Services:
1. Provide (1) trip, (2) days for start-up and training services.

B. Field Tests:

1. To be completed in conjunction with the Installation Contractor.

2. Repeatability of performance shall be demonstrated by testing five consecutive reprime cycles.
Full pump capacity (flow) shall be achieved within five minutes during each cycle.

3. Liquid to be used for reprime test shall be water.

4. Upon request from the engineer, certified reprime performance test results, prepared by the
manufacturer, and certified by a registered professional engineer, shall be submitted for approval
prior to shipment.

END OF SECTION

233305 City of Billings
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